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There are two ways to export video from Blender: Render Output and Video Sequence Editor. Render Output will render your video as an image sequence, which you can then encode into a video file using a video encoder. Video Sequence Editor will render your video directly to a video file.To export video from Blender:Open the video file you want to
export in Blender.Go to File > Export > Render Output.Choose the format you want to export your video as.Choose the destination for your exported video file.Click Export.Your video will now be exported as an image sequence or video file.Q: How do I export from blender to mp4?A: There are a few ways to do this, but the easiest way is to use the
"Render" button in the top toolbar. This will open up the render settings window, where you can select your desired output format (in this case, MP4) and output location.Q: How do I convert a blender animation to a video?A: There are a few ways to do this, but the easiest way is to use the Render button in the top left corner of the Blender interface.
This will open up the render settings window, where you can choose the output format, resolution, and other settings. Once you're happy with the settings, click the "Render" button at the bottom of the window to start the render process.Q: How do I export a Render in Blender?A: There are a few ways to export a render in Blender. One way is to use
the built-in "Render out" option in the Render tab. This will render the scene and save the image to your computer.Another way is to use the "Save Image" option in the Image Editor. This will also render the scene and save the image to your computer.You can also use the "Viewer Node" in the compositor to save the render to an image file.Q: What is
the best video format for blender?A: There is no "best" video format for Blender. Different formats have different advantages and disadvantages, and the best format for a given project will depend on the specific requirements of that project. Some of the most popular video formats include AVI, MOV, and MPEG. Science & TechnologyJune 20,2024
Hello, and welcome to another session on using the new Blender for video editing. In this article, we will discuss how to render your work and save it as a video file using Blender's Video Sequence Editor. To export your video work in Blender, follow these steps: Setting Up File Location: Start by selecting the properties editor in the video editing
screen layout. Scroll down to the output section and choose a file location and name for your video file. Choosing File Format: Under the output settings, change the file format from PNG to FFmpeg video. Then, select the H.264 and MP4 presets for encoding. Adjusting Audio Settings: If your project includes audio, ensure that the audio codec is set to
something like AAC in the encoding options. Rendering the Video: Once all the settings are configured, go to the render menu and select "Render Animation" to start the rendering process. Optimizing Performance: To optimize performance during rendering, disable the option to render in a new window by changing it to 'keep user interface' in the
preferences under the interface section. By following these steps, you can efficiently render and export your video projects in Blender's Video Sequence Editor. Keywords Blender, Video Editing, Rendering, MP4, Video Sequence Editor, Exporting, Performance Optimization FAQ Can I export my video projects in formats other than MP4 in Blender?
Yes, Blender offers various output formats besides MP4, allowing you to choose the most suitable format for your specific needs. Is it necessary to adjust audio settings for video rendering in Blender? If your video project includes audio, it's recommended to configure the audio codec settings to ensure the audio is encoded correctly in the final output.
How can I improve rendering performance in Blender? To improve rendering performance in Blender, you can disable the option to render in a new window, as it can help allocate more resources to the rendering process itself. Reddit and its partners use cookies and similar technologies to provide you with a better experience. By accepting all
cookies, you agree to our use of cookies to deliver and maintain our services and site, improve the quality of Reddit, personalize Reddit content and advertising, and measure the effectiveness of advertising. By rejecting non-essential cookies, Reddit may still use certain cookies to ensure the proper functionality of our platform. For more information,
please see our Cookie Notice and our Privacy Policy. Creating your own animations in Blender is a rewarding process where you can create your own world and story and then promote it to the world with pride for what you were able to create. But even after finishing your animation, you still need to render it and save the video as an external file.To
export your rendered animation from Blender, you will want to complete the checklist below.Set The Correct Frame RateDefine The Resolution Of The AnimationSet Up Your Scene CameraChoose The Location For Your RenderSet The Start And End Frames Of The AnimationSelect The Render Animation OptionAfter Rendering Make Sure To Preview
The Created File To Ensure All Is Correctlt is a relatively simple checklist but each step is important for completing the animation process. Most important will be to ensure that your animation goes to the location that you want it to so that you can locate the file after rendering.How To Export A Video From Blender?Rendering your 3D animation from
Blender is simple enough to do once you know all the little steps needed to render the animation correctly. By correctly we mean having the right frame rate and resolution for the animation.Of course, the steps required to correctly render the video are not all done before the actual render, but at various stages in the project. So let’s run through
each step and when it needs to be completed.Before you begin actually creating the models for your animation and begin the process of rigging and creating your keyframes, you should determine the frame rate of the target video output as one of the first things you can do.We need to do this early because the frame rate will directly impact how the
keyframes of your animation will work. For example, create a keyframe of a bouncing ball that takes a second to bounce at 30fps, then change the frame rate to 60fps.Even though the frame rate has changed the length of the bouncing ball animation is still just 30 frames, which means that the ball will now fall twice as fast, changing the final
result.To change your frame rate, along with completing the various other steps in the export process, go to the render tab in the properties panel, and the frame rate will be changeable towards the top of the panel as seen in this image.Animation Frame RateAbove the frame rate option in the same tab, you can define the resolution of the animation
that will be rendered. While you do not need to change this straight away you may choose to anyway.We recommend as an additional tip to set the resolution of the animation to be half of what your final output is going to be on the X and Y axis. This will dramatically reduce the render time for each frame. We recommend this because you will want to
test render your animation before rendering the final result, and so a lower resolution will create a quick result that acts as a good representation of the final product.Set To Half Target ResolutionDuring your project, you will need to make sure that your cameras are set up correctly in the 3D viewport. This is where test rendering at a lower
resolution becomes valuables you can set up your camera in different positions and test render your scene from different angles.Set your Camera Positioning In The ViewportYou can also adjust the number of frames for your animation at this point, which can be changed either from the properties panel or from the timeline, as seen directly
below.Another tip is to only test render a part of your animation, to further speed things up. If you have a 10-second animation running at 30fps, then you can set the test render to only the first 2 seconds by setting the end frame to 60.Set The Frame RangeCombined with the lowering of the resolution, your test renders can be produced quickly
preventing you from having to wait too long before continuing the project.By the time you finish the animation itself, you will almost be ready to render and export it. The next step, which can also be completed earlier on in the process, is the defined location of your video file.By default, animations renders are saved to the temp file on your computer,
which is otherwise difficult to access and has the flaw of being, you guessed it, temporary. This means that any video stored there is deleted periodically.Learn new skills for next to nothing on Skillshare!lt is a much better practice to select a new location to save your render. While you can do this earlier, we recommend waiting until after you have
test rendered the animation, so that the test renders go to the temp file first.You can change the target file by going to the Properties Panel > Render Tab > Select The Open Button, which opens the file browser.Output To Another FolderInstead of selecting an existing folder to save your render to, you should instead create a new folder in an easy to
reach location exclusive for the animation. This will be particularly useful if you choose the safe method of rendering animations, which we will cover later on. Keep your new folder empty and aside from your render.New Folder On Desktop To Save AnimationBelow the option to choose your target location you will also be able to choose the file format
that will be created on export. There is a reason why it is actually a good idea to set this to a png format but if you want to export it straight to a movie file select where it says PNG and then choose one of the video formats from the menu, such as FFmpeg.At this point, you are ready to start the rendering process, so go to the render menu in the
header bar of the Blender interface and select render animation. Make sure that everything else is set before you select the render button.Render AnimationOnce you have rendered the animation, locate the video file on your desktop browser and select the video file to open it using your own video player, you don’t need to use Blender for this
step.What Is The Best Video Output Choice In Blender?With Blender, you are able to choose which video format that you wish to export your animation as, and each format stores your information in a slightly different way.What is important is the ability to play your animation without issue, which the majority of file formats available to you
allow.Which format you choose is not going to be the most important decision you make today, so our advice is normally to go with what you know.To change your file format for the video output, go to the output tab where you are able to control the target location of the animation.Below you will be able to change your file format, which should be a
picture format by default. Clicking here opens up a menu of all the picture and video formats that you can use without additional addons.File FormatOur recommendation is to go with FFmpeg as the file format for your movies, but AVI Raw will do the job as well.All is not complete, however, as you then need to choose the right settings for your file
format. There will be a closed subsection labeled Encoding just below, open this up to access the format settings.Encode OptionsHere, you will want to choose the container that you want to use to store the video file. Again this does not have much of an impact on the playability of the animation as most containers are widely recognized and used.The
Matroska container is a flexible choice that holds a lot of information, while QuickTime and AVI containers a great for saving on storage space.MPEG-4 however is the ideal choice for excellent final quality and is recognized by almost any application and media player. It is our choice when we create animations in Blender.You then need to choose the
video options that you want to use. You can keep these as they are but the settings that we use are h.264 for the video codec, High Quality for the output quality, and a good encoding speed. Changing these options affects the trade-off between speed of encoding and quality of the final result.For production-level projects, use a lossless quality with a
slow encoding speed to maximize the final quality, although the result is a marginal improvement to the video as a whole.Rendering An Edited Video In The Video Sequence EditorBlender is home to so many tools and functions that you may be forgiven for not knowing one of its most surprising secrets, that it has a full video editing suite. Not only are
you able to render 3D animations after creating them in the 3D viewport, but you are also able to edit those renders in the video sequence editor.The Video Sequence Editor, or VSE for short, allows you to import either movie files or image sequences into its timeline, allowing you to begin editing that file as you would in another video editing software
like DaVinci Resolve.Admittedly, this is one of the least progressive areas of the Blender software, and in terms of both performance and functionality, it falls well behind the more traditional video editing applications that you may be using.When you import a video into the VSE, one thing that Blender does not tell you is that video now has rendering
priority over what you have in the viewport.The Video Sequence EditorSo when you go to press that render animation button, it will begin encoding and exporting the file editing in the VSE and not what you have set up in the viewport. This is one of the reasons why video editing has a separate template to 3D modeling in the Blender interface.The
options that you use in the properties panel to set your animation renders work the same way for videos in the VSE, so make sure that these options are set up accordingly to what you want from your video file, including the output file and target resolution.Because we are effectively encoding rather than rendering, the process is much faster than
rendering an animation from the viewport as the data is already there in the edited video. Typically a 5-minute edited video may take 1-2 minutes to encode depending on the settings used for example.Other than the fact that you are rendering from the VSE there is very little change to the rendering process so just adapt the steps listed at the top of
this article to your video edits instead.Saving Your Video File In An Appropriate LocationOne of the more important troubleshooting steps that you can take is to set an appropriate output location for your rendered animation.By default, the animation will be sent to the temp file on your computer if you are using a windows device, and to a similar
location if using any other operating system.This means that if you render your animation and then shut down your computer, you risk losing the animation that you rendered.In Blender, temp files are best suited to caching data like physics simulations and baking elements of a scene, but it is not where you should be saving your renders if you want
to keep them.You do not want to change your target output straight away though as it can be useful to have the temp file for your test renders.A test render is a small section of the project that you choose to render at a lower resolution to analyze the quality of the animation, object positioning, camera placement, etc.For the final render, however, you
will want to choose a destination that is easy to access, and a bit more permanent.In the output tab of the Properties panel, select the output branch to open if not already, and then select the folder icon to bring up the file browser.Select the desktop as your initial target location, so you can access the file quickly after the render is finished.You will
also want to create a folder to store your animation in, so select the folder icon at the top of the file browser and then name the new folder to something appropriate.Open up the folder and then press the blue Accept button to confirm that as the target location for your render.The Best Method For Rendering Animations In BlenderIf you follow the
steps above you should be able to successfully render your animation and export it to your target location and file format, but there is a risk to doing it the traditional way.Rendering a whole animation takes time, and a lot of time at that. If a single frame takes 10 seconds to render, then how long would a 300 frame render take to finish? Well it would
take around 50 minutes in total, and if your using cycles as your render engine, it could take much more than that to finish rendering.The risk here is when your machine crashes during the rendering process. Imagine being 30 minutes into the render and then Blender suddenly and abruptly closes. All that time spent rendering has been wasted, as
the file has not had a chance to be exported.While this is certainly frustrating, there is a much safe method that only takes a little bit of extra time, and that is to render your animation as an image sequence.A movie file is a single file for playing video content, while an image sequence is a group of numbered frames that can be played sequentially to
view the video.Each frame is saved as its own image and you can access these individual frames from the target location, perhaps using a frame and editing it to be the thumbnail of a Youtube video for example (Make sure to save the edit to a different location!).But where this is really useful is as a countermeasure to crashing. If Blender fails 100
frames into rendering a movie file, then the entire render has failed and you will need to start over.If rendering as an image sequence then the first 100 frames will be saved as 100 images, allowing you to reopen Blender, set the start frame to 101, and restart the rendering process from there, without needing to render the first 100 frames again.Is
Rendering As A JPEG Better Than As An MP4?So is it better to render as an image format like a jpeg or a PNG instead of a video format like MP4? For the initial render the answer is yes, but it is much easier to deal with a single movie file than it is an image sequence of 300 frames.The solution is to initially render your animation as an image
sequence and then import that image sequence into your VSE. Even if you chose not to actually edit the content, you can import the image sequence and then immediately export it as a movie file.To do this first open up your Video editing workspace in the Blender project by pressing the plus button in the workspace tabs and selecting the option for
video editing.Add Video Editing WorkspaceThen go to the add menu in the video sequence editor and select image sequence. This will open up the file browser from where you will need to locate where you saved your rendered frames.The frames will appear in numerical order. Press the A key to select every item in your folder, and if you have
created a folder exclusively for the render, you won’t have to worry about other files being selected accidentally.Select Add Image Strip to import your image sequence into your video editor, and make sure it is positioned at frame 1.Add Image StripThen return to the Output tab in the properties panel and set the output format to a movie file such as
the MP4 format. You do not need to change the output location if you don’t want to.Then select the render animation option again, only this time Blender file encode your image sequence and convert it into a video file, which will be visible in the target location.Thanks For Reading The ArticleWe appreciate you taking the time to read the article. We
hope that you were able to find the information that you were searching for. Below we have compiled a list of additional topics that you may be interested in reading.Color grading techniques for cinematic post-processing in Blender.Continue ReadingAchieving natural lighting effects with HDR environments in Blender.Continue Reading Blender is a
widely-used open-source 3D modeling and animation software that is popular among artists and designers for creating high-quality animations, visual effects, and video content. Exporting video from Blender is a crucial step in the production process, as it allows users to save their work in a format that can be easily shared, uploaded to online
platforms, or used in other software programs. In this comprehensive guide, we will walk you through the process of exporting video from Blender, covering everything from setting up your project to choosing the right export settings. Setting up your project Before you can export your video from Blender, you need to make sure that your project is
set up correctly. This includes importing your 3D models, setting up cameras, lighting, and materials, and adding any animations or effects that you want to include in your final video. Once your project is ready, you can begin the process of exporting your video. Choosing the right output format When exporting video from Blender, it is important to
choose the right output format to ensure that your video looks its best when played back on different devices or uploaded to online platforms. Blender offers a variety of output formats to choose from, including AVI, MPEG, QuickTime, and more. Each format has its own set of advantages and disadvantages, so it is important to choose the one that
best suits your needs. To choose the right output format, go to the Output tab in the Properties panel and select the format that you want to use from the drop-down menu. You can also adjust the encoding settings, such as the video codec, frame rate, and resolution, to further customize your export settings. Once you have chosen the right output
format, you can proceed to the next step in the export process. Exporting your video Once you have set up your project and chosen the right output format, you can begin the process of exporting your video from Blender. To do this, go to the Render tab in the Properties panel and click on the Render Animation button. Blender will then start
rendering your video frame by frame, saving each frame as an image file. Once the rendering process is complete, Blender will automatically compile the images into a video file using the output format and settings that you have selected. You can then save the video file to your computer or upload it to an online platform to share with others. Tips for
exporting video from Blender Use the right output format: Choosing the right output format is crucial for ensuring that your video looks its best when played back on different devices or uploaded to online platforms. Experiment with different formats and settings to find the one that works best for your project. Adjust the encoding settings: In addition
to choosing the right output format, you can also adjust the encoding settings to further customize your export settings. This includes adjusting the video codec, frame rate, resolution, and other settings to optimize the quality and file size of your video. Use the Video Sequencer Editor: Blender offers a Video Sequencer Editor that allows you to edit
and arrange video clips, images, and animations in a timeline format. This can be a useful tool for creating complex video projects and adding effects, transitions, and titles to your videos before exporting them. Check your render settings: Before exporting your video from Blender, make sure to check your render settings to ensure that they are set up
correctly. This includes adjusting the resolution, frame rate, and other settings to match your project requirements. Save multiple versions: To avoid losing your work, it is a good idea to save multiple versions of your project as you work on it. This way, you can easily go back to a previous version if something goes wrong during the export process. In
conclusion, exporting video from Blender is a simple process that can be customized to suit your project requirements. By following the steps outlined in this guide and experimenting with different output formats and settings, you can create high-quality videos that can be easily shared and enjoyed by others. Whether you are a beginner or an
experienced Blender user, this guide will help you navigate the export process and create stunning videos with ease. How to Export Video from Blender: A Comprehensive Guide Blender is a powerful open-source 3D creation suite that offers a plethora of tools and features for 3D modeling, animation, visual effects, rendering, and video editing. While
many users are drawn to its modeling and animation capabilities, the software also includes a video sequence editor (VSE) which allows users to edit videos and export them in a variety of formats. This guide will take you step-by-step through the process of exporting video from Blender, whether you’'re working with animated sequences, action
footage, or even audio. Getting Started with Blender Before we dive into the exporting process, it’s important to understand a few fundamental concepts: User Interface: Blender’s interface can be daunting for newcomers. It consists of various panels and windows that display the 3D viewport, timeline, properties, and more. Familiarize yourself with
these sections as they will be key in the exporting process. Project Settings: Before exporting, ensure your project settings are configured correctly. Navigate to the render properties panel (camera icon) and set your resolution, frame rate, and output format. Video Sequence Editor: Blender features a built-in video editor, making it an excellent choice
for basic video editing. The VSE allows you to combine video clips, images, and animation, all of which can be exported as a single video file. Preparing Your Video for Export Creating Your Video Sequence: Start by opening the "Video Editing" workspace in Blender. This will change the layout to facilitate video editing. You can add your video clips
and audio files by using the Add menu in the Sequencer window. Editing Your Video: Use the tools available in the VSE to trim, cut, or modify your clips as necessary. You can move clips around on the timeline, adjust audio levels, and apply various effects to enhance your sequence. Scene and Render Settings: Before exporting, review your scene
settings to ensure everything is as you want it. Check the following: Resolution: Set your desired width and height in pixels for the final output. Common resolutions include 1920x 1080 for Full HD, or 3840x2160 for 4K. Frame Rate: Standard frame rates are 24, 30, or 60 FPS. Choose the one that matches your project requirements. Render Engine: If
your video includes 3D elements, select the appropriate render engine (Eevee, Cycles) in the render properties. Exporting Video: Step-by-Step Process Once your video sequence is complete and settings are configured, you’re ready to export your video. Follow the steps outlined below: Step 1: Open the Output Properties Navigate to the "Output
Properties" tab (represented by a printer icon) in the Properties Panel on the right side of the screen. This is where you will configure the settings specific to your export. Step 2: Set Output File Directory Under the "Output" section, you will see an option to define the output directory: Click the folder icon to choose where you want your exported file
to be saved. Make sure you select a location that is easy to access after the export is complete. Step 3: Choose Output File Format and Codec Within the "Output" properties, there are various options to determine the type of file you want to create: File Format: Use the drop-down menu to select the desired format. Common options include FFmpeg
video, AVI, QuickTime, and more. Container: If you selected FFmpeg, you will also need to choose the container format (e.g., MPEG, MOV). Video Codec: Depending on the container type, select a codec that suits your needs. For instance, H.264 is a widely used codec that balances quality and file size. Step 4: Configure Audio Settings (If Needed) If
your video sequence includes audio, ensure that the audio settings are correct: In the "Encoding" section (only shown if you select FFmpeg), check the "Audio Codec" dropdown and select an appropriate codec such as AAC or PCM. Adjust the audio bitrate for quality versus file size considerations. Step 5: Final Render Settings At this stage, ensure all
settings are correct: Check the resolution, frame rate, output location, and file format. If you're satisfied, you can prepare for rendering. Rendering Your Video With all settings configured, it’s time to render your video: Navigate to the top menu bar and select Render > Render Animation. Alternatively, you can press Ctrl + F12 as a shortcut. Blender
will begin rendering each frame of your video sequence. This process can take some time depending on the complexity of your project, your system’s performance, and the render settings you've selected. The progress will be shown in the status bar, and you’ll see the frames being processed. Step 6: Check the Output After the rendering process is
complete: Navigate to the output directory you specified. Verify that the exported video file is present and check its quality by playing it in a video player. Troubleshooting Common Export Issues Even with a seamless setup, issues can sometimes arise when exporting videos in Blender. Here are some common troubleshooting tips: No Output File
Created: If no output file is created, recheck your output settings. Make sure a valid folder location is selected and the file format is correct. Exporting Takes Too Long: The time taken for rendering can vary. Reduce resolution and use simpler render settings for quicker exports for tests. When satisfied, switch back to higher settings for the final
render. Audio Issues: If the audio is missing or out of sync, double-check the audio codec and playback settings. Ensure all audio strips are aligned properly in the timeline. Color and Quality: If the video quality is not as expected, you might need to configure the video and audio bitrates in the encoding settings. Advanced Export Techniques For users
looking to push Blender to its limits, here are some advanced techniques for exporting videos: Multi-layered Video Imports: If your final composition involves several clips or layers, consider rendering them out separately and combining them in another editing software for added flexibility. Image Sequences: For high-quality animation, you can render
your animation as an image sequence (such as PNG or OpenEXR), then compile these images into a video file afterward using Blender or external software. Using Compositing Nodes: The Compositor in Blender allows more advanced editing functionality. Adjusting footage using nodes can enhance the quality of your final output, adding effects and
corrections before exporting. Batch Render: For larger projects, consider using screenshots to organize scenes and render them in batches, reducing time spent managing files. Alternatives to Blender for Video Exporting If you find Blender’s rendering and exporting process cumbersome, or if you wish to explore alternatives, consider these video
editing tools: Adobe Premiere Pro: A professional-grade editing software that offers advanced features and integration with other Adobe products. DaVinci Resolve: A powerful tool known for its color correction and audio post-production capabilities. A free version is available with many features. HitFilm Express: A free software combining editing,
visual effects, and 3D compositing tools, suitable for beginners and advanced users alike. Conclusion Exporting video from Blender is a crucial skill for any user looking to leverage the power of this versatile software. By following the outlined steps and configurations, you can ensure a smooth exporting process. With practice, you’ll be able to refine
your video editing and exporting techniques, leading to professional-quality outputs. Whether you’re creating animations, editing videos, or composing soundtracks, Blender has the tools necessary to achieve your creative vision. Keep experimenting with Blender’s capabilities, and don’t hesitate to explore other resources and forums for tips and
tricks from the vibrant Blender community. Happy exporting!



